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Introduction 
The Kelverion Integration Module for ServiceNow is an Integration Module for Runbook Studio and 
Azure Automation that lets you integrate your runbooks with ServiceNow. The Kelverion Integration 
Module for ServiceNow is Microsoft Azure Certified. 

The integration module includes the following activities: 

Add-ServiceNowAttachmentContent Uploads an attachment to the specified ServiceNow 
record. 

Get-ServiceNowAttachmentContent Downloads the content BLOB from the specified 
ServiceNow attachment record. 

Get-ServiceNowAttachmentInfo Retrieves information about the attachments 
associated with the specified ServiceNow record. 

Get-ServiceNowRecord Retrieves records from a ServiceNow table. 

Get-ServiceNowRecordCount Gets the number of records in a ServiceNow table. 

Get-ServiceNowRefreshToken Get a refresh token for OAuth 2.0 authentication. 

Import-ServiceNowRecord Imports a record using a ServiceNow import set. 

New-ServiceNowRecord Inserts a new record into a ServiceNow table. 

Remove-ServiceNowRecord Removes the specified record from a ServiceNow table. 

Set-ServiceNowRecord Updates the values of one or more fields in the 
specified ServiceNow record. 

System Requirements 
The Integration Module for ServiceNow requires the following software to be installed and 
configured prior to implementing the integration.  

• Kelverion Runbook Studio 5.6 

• Microsoft .NET Framework 4.7.2 

The integration module Supports the following versions of ServiceNow: 

• Zurich 

• Yokohama 

• Xanadu 

Important: The Kelverion Integration Module for ServiceNow requires the user, that is used to 
connect to ServiceNow, be configured to use the English language. 
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Changes Affecting Backwards Compatibility 
Starting with version 3.0 connection asset and Smart Connection fields have been updated to 
support OAuth 2.0 authentication. As a result, connection assets are not backwards compatible 
with previous versions.  

Before upgrading the module in Azure Automation, you must first remove all Kelverion.ServiceNow 
connection assets as well as the Kelverion.ServiceNow connection type. For more information, refer 
to Appendix A in the Kelverion Integration Module for ServiceNow User Guide. After you have upgraded 
the module, you can recreate your connection assets. 

Important: Before removing connection assets, you should document the connection asset name(s) 
and field values so that they can be recreated. Using the same connection asset names, will save you 
from having to update your runbooks. 

You must also update your Smart Connections in Runbook studio as some configuration property 
names have changed. 

Installing the Integration Module 
The easiest way to install and deploy the Integration Module for ServiceNow is from the PowerShell 
Gallery, but you can also download the module from Kelverion and perform the steps manually. 

You must install and deploy the Integration Module to each Azure Automation Account and Hybrid 
Worker host system that you plan to use to run your runbooks. You must also install the Integration 
Module on any Runbook Studio host systems that you will be using to build and manage your 
runbooks. 

Using the PowerShell Gallery 
Using the commands in the PowerShellGet module you can download the Kelverion Integration 
Module for ServiceNow from the PowerShell Gallery and install it on your local computer. You can 
also deploy the module directly from the PowerShell Gallery to any of your Azure Automation 
Accounts. 

Install the integration module on your local computer or hybrid runbook worker: 

1. Confirm that the PowerShellGet module installed. 

2. Start a PowerShell window as an Administrator and run the command: 
Install-Module -Name Kelverion.ServiceNow -Scope AllUsers 

Upload the integration module to an Azure Automation account: 

1. Go to the PowerShell Gallery. 

2. On the Azure Automation tab, click Deploy to Azure Automation.  

3. Select the Automation Account that you want to deploy the module to and click OK. 

https://www.powershellgallery.com/packages/Kelverion.Servicenow
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Manual Installation 
Alternatively, you can download the Integration Module package from Kelverion and deploy it 
manually to your local computer, hybrid workers and Automation Accounts. 

The download package from Kelverion includes a .zip file containing the Integration Module as well 
as the User Guide and Release Notes. The following instructions assume that you have unzipped the 
download package and have access to the .zip file containing the Integration Module. 

Install the integration module on your local computer or hybrid runbook worker: 

1. Copy the Kelverion.Servicenow.zip file to your local computer. 

2. Right-click on the file and select Properties.  

3. Click the General tab. If necessary, click Unblock, and then click OK. 

4. Unzip the Kelverion.Servicenow.zip file. 

5. Copy the Kelverion.Servicenow folder to a location in the %PsModulePath% path. 

Important: When installing the Integration Module on a Hybrid Worker, you must use a location that 
is accessible to all users of the computer. 

Upload the integration module to an Azure Automation account: 

1. Sign into Microsoft Azure. 

2. Open the Automation Account that you want to upload the module to. 

3. Click Modules under Shared Resources. The list of installed modules is displayed. 

4. Click Add a module at the top of the list. 

5. In the Upload File box, select the Kelverion.Servicenow.zip file that you downloaded. 

6. Click OK. Importing the module may take several minutes. 

Licensing the Integration Module 

Licenses for Kelverion Integration Modules are managed and deployed using the Kelverion Runbook 
Studio and Automation Connection Assets. 

Register an Integration Module license with Runbook Studio: 

1. Open Kelverion Runbook Studio. 

2. On the File tab, click About. 

3. Click License Information. 

4. Click the Integration Modules tab, and then click Add License. 

5. Select the integration module license file (.kaml) and click Open. 

6. You should see your entitlements displayed in the list. 

7. Click OK. 

https://portal.azure.com/
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Important: Entitlements will not display until after the Integration Module has been installed on the 
Runbook Studio computer. 

Create a Connection Asset with a license key and upload it to Azure: 

1. On the Home tab, click Sign In. The Sign In dialog appears. 

2. Sign into your account. 

3. In the Active Azure Automation Account box, select the account that you want to add the 
connection asset to. 

4. Click New Asset and then click Connection. The New Connection dialog appears. 

5. In the Name field, enter a name to identify the connection. 

6. In the Connection Type field, select the desired connection type. 

7. Enter the appropriate connection information in the provided fields. 

8. Click OK.  

Update all Connection Assets license keys and upload them to Azure: 

1. On the Home tab, click Sign In. The Sign In dialog appears. 

2. Sign into your account. 

3. In the Explorer panel, click the Azure (Online) group. 

4. Right-click the Azure Automation Account that contains the connection assets you want to 
update, and then and then click Update License Keys. A summary is displayed. 

Known Issues 
• Creating a filter in Runbook Studio to search using a journal field may return unexpected 

results when using the Equals operator and the Empty String data source. 

• Creating a filter in Runbook Studio to search using some reference fields may return 
unexpected result when using a Constant Value data source and the references Display 
Name. In this case, it is recommended that you use the references Sys ID when building the 
filter in Runbook Studio. 

• This version of the integration module is not backwards compatible with previous versions. 
Before upgrading your Automation accounts to this version your must first remove all 
Kelverion.ServiceNow connection assets as well as the Kelverion.ServiceNow connection 
type.  

• As of the publication of this document both the Set-AzAutomationConnectionFieldValue 
and Set-AzureRmAutomationConnectionFieldValue cmdlets fail due to some internal 
defect. So, if you want to use automation to periodically update the OAuth refresh token 
used by your connection assets your only recourse is to retrieve the connection asset, 
update the RefreshToken field, remove the connection asset and finally recreate it using the 
updated field values. 
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Version History 

Version 3.8 
• Added support for ServiceNow Zurich. 

Version 3.7 
• Added support for ServiceNow Yokohama. 

Version 3.6 
• Added support for ServiceNow Xanadu. 

Version 3.5 
• Added support for ServiceNow Washington. 

Version 3.4 
• Added support for ServiceNow Vancouver. 

Version 3.3 
• Added support for ServiceNow Utah. 

Version 3.2 
• Added support for ServiceNow Tokyo. 
• Fixed an issue where HTTP 408 Request errors may be observed when the connecting to 

instances of ServiceNow Tokyo. 

Version 3.1 
• Added support for ServiceNow San Diego. 

Version 3.0 
• Added support for OAuth 2.0 authentication.  Note: Connection assets are not backwards 

compatible with previous versions. Please see "Changes Affecting Backwards Compatibility" 

Version 2.9 
• Added support for ServiceNow Rome. 
• Fixed issue with uploading runbooks to Azure when the runbook contains a Get-

ServiceNowRecord activity configured to retrieve a specific record by its Sys ID. 
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Version 2.8 
• Added support for ServiceNow Quebec. 

• Fixed issue with publishing empty date and time values from ServiceNow. The output is now 
a null value, instead of January 1, 0001 00:00:00.0000000 UTC. 

• Added an ActualValues switch to the Get-ServiceNowRecords activity, that when present 
will cause the activity to retrieve actual values from ServiceNow instead of display values. 
You can use this feature in situations where you must obtain the Sys ID for a reference field 
instead of the display value. Note that this switch affects all fields, which means Choice 
fields will output their internal values and DateTime fields will output UTC. 

Version 2.7 
• Added support for ServiceNow Paris. 

• Fixed issue in Set-ServiceNowRecord in which empty Sys ID values were being output. 

Version 2.6 
• Added support for ServiceNow Orlando. 

• Added ability to search by Sys ID to the Get-ServiceNowRecord activity. 

• Added ability to retrieve all records in a table to the Get-ServiceNowRecord activity. 

• Added ability to count all the records in a table to the Get-ServiceNowRecordCount activity. 

• Simplified the Get-ServiceNowAttachmentContent activity so that it just returns an array of 
bytes instead of custom data object. 

Version 2.5 
• Fixed a problem with Get-ServiceNowRecord ignoring the optional fields OrderBy, Limit, 

Offset and Ascending when converting to PowerShell or when uploading graphical runbooks 
to Azure Automation. 

Version 2.4 
• Added support for ServiceNow New York. 

• Added Get-ServiceNowRecordCount activity. 

• Improved notification when no valid licenses can be found. 

Version 2.3 
• Added support for ServiceNow Madrid. 

• Added support for TLS 1.2 

• Fixed problem that can occur when retrieving table information from the ServiceNow 
Dictionary table. 
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Version 2.2 
• Added support for ServiceNow London. 

• Fixed issue with Get-ServiceNowRecord that caused the activity to fail if a value was not 
specified for the optional Limit (Record Limit) parameter. The Limit now defaults to 250 
records if no value is specified. 

Version 2.1 
• Removed remote NTP server dependency. 

Version 2.0 
• Removed requirement for Kelverion Management Server. License files and entitlements are 

now managed in Kelverion Runbook Studio. 

• This version is not backwards compatible with previous versions due to changes to the 
fields of the connection type used by this module. It is in effect a new integration module 
with a new name and module identifier. 

Version 1.2 
• Add an Import-ServiceNowRecord activity to support importing data into ServiceNow using 

import sets. 

• Added support for TLS 1.2 

• Added new connection properties UserDateFormat and UserTimeFormat for specifying 
ServiceNow user date and time formats. If you cannot see these properties after importing 
the new module, you will have to remove the Kelverion.ServiceNow connection type and re-
import the module. For details, see Removing Azure Automation Connection Type 

Version 1.1 
• Support for Runbook Studio v2.0 

• Update License Agreement 

Version 1.0 
• The Kelverion Integration Module for ServiceNow is a new Integration Module for Runbook 

Studio and Azure Automation that lets you integrate your runbooks with ServiceNow. 
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